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Overview 

You must have Windows and Internet Explorer to use Nightingale on Demand.  To set up your 

computer, you need to install a few components and adjust your Internet Explorer settings on each 

computer.  This guide will provide you with step by step instructions on how to set your computer up to 

access Nightingale.  

You must adjust these settings for each user (person) logging into the computer, since Internet Explorer 

settings that are set for one Windows User Profile will not carry over to another Windows User Profile.  

 

Note: This guide will cover the Windows 10 operating system only. 

 

We recommend you reset the Internet Explorer settings back to default before proceeding with 

this document to adjust your Internet Explorer settings 

Accessing Nightingale on Windows  

 

In order to access Nightingale on Windows 10, you will need to navigate and use the Internet Explorer 

browser. To access the browser, click on the Start button and start typing ‘Internet Explorer’ to search for 

and select the application. 
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Note: For future convenience, you may want to pin Internet Explorer to the taskbar for easier access to 

the application without having to search every time. To do so, upon searching for the browser through 

the Start menu, right-click on the application and select ‘Pin to taskbar’. A shortcut for the Internet Explorer 

browser is placed on the taskbar, and can be opened from there instead for easier access. 

 

 
 

Installing Java 

 

When using Nightingale on Demand, you can perform several tasks such as signing documents 

electronically and drawing on growth charts and body images in patient encounters. In order to use these 

features, you will need to install a program on your computer called the Java Runtime Environment (JRE 

or Java). In order to install Java:  

 

1. Log on to your computer using a Windows profile that has administrative rights, so that you can 

download and install the Java program. 
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2. Recommended version of JRE  

a. For PCs running a 64-bit Windows operating system (OS): The bit-ness (i.e. 32 bits or 64 

bits) of the JRE must match the bit-ness of Internet Explorer that you use. It is 

recommended that NOD users use the 32-bit version of Internet Explorer and the 32-bit 

version of the JRE. Both 32-bit and 64-bit versions of Internet Explorer are available on a 

PC with a 64-bit OS, but the default version is 32-bits. 

b. At the time of writing, the recommended version of JRE for Windows 7, 8, 8.1 and 10 is 
8u102 (also referred to as 8 update 102 and 1.8.0_102).  

 

3. Download and install the JRE from the following website: 

http://www.oracle.com/technetwork/java/javase/downloads/index.html.  

4. When you get to the website: 

a. In the section labelled “Java Platform, Standard Edition click on the button labelled “JRE 

DOWNLOAD”.  

b. In the new page, click on “Accept License Agreement”.  

c. Select the “Windows x86 Offline link”  – the larger file. 

d. A pop-up window will prompt you to start the java download.  

e. Click on Run. 

f. Follow the instructions on the screen to install the program. 

 

  

http://www.oracle.com/technetwork/java/javase/downloads/index.html
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Adjusting Java Settings 

 

Once Java has been installed, you will need to adjust the Java settings in order for the Java program to 

function properly on Nightingale. 

  

 

 

 

To adjust Java, you will need to access the Control Panel.  To 

access the control panel, place your mouse over the Start button 

and right-click on it. Select Control Panel from the menu that 

appears  

 

 

 

 

 

 

 

 

 

 

 

 

 

Once the Control Panel opens, double click on Java (32-bit). 
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Once open, click on the Java tab. Disable or delete any previous versions of Java that may be 

installed. Click OK. 

Click on the Security tab. Select High security level. 

 

Once completed, delete any residual Temporary Internet files in the Java cache. To delete those files, 

click on the General tab. 

 
 

Click on the  button to continue. 



Last Updated October 2016   

Nightingale – Getting Started Guide – Windows 10      Page 8 of 19 

 
 

Click on  button to remove the files.  After the files have deleted, click on the  

button. 
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Setting Regional and Language Defaults 

 

In order for items such as consult letters, prescriptions and reports to print properly, you will need to 

adjust your computer’s language settings. Open the Control Panel. 

 

 
 

 

 

Once the Control Panel opens, 

locate the Language option.   
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Once the Language control panel opens, select English (United States) and then click on Change date, 

time, or number formats option. 

 

 
 

 

The Region window will then open.  

Click on the  button. 
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Locate the Measurement system and ensure that 

U.S. is selected.  Click on the  button to 

save the changes. 

 

 

 

 

 

 

 

 

 

 

 

Adjusting Internet Explorer 11 Settings 

 

In order to be able to access Nightingale successfully using Windows 10 and Internet Explorer 11, you 

will need to adjust the various Internet Explorer settings. By default the program menu bar is hidden when 

Internet Explorer is open.   

 

 
 

To display the program menu bar, place the mouse near the top of the page and then click on the right 

mouse button to display a pop-up menu.  Select Menu bar from the options with the left mouse button.  

The Menu bar will now display. 

 

Alternatively, pressing the ALT key will temporarily display the menu bar.  
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Turning pop-up blockers off 

 

You must ensure that Pop-ups are allowed to appear before logging on to the Nightingale program. To 

do this, you must ensure that the Pop-up Blocker option is turned off. To turn off the pop-up blocker 

feature, click on the Tools menu. 

 

 
 

Once the tools menu opens, select Pop-up Blocker and then select the option “Turn off Pop-up Blocker”.  

If the option “Turn on Pop-up Blocker” displays, pop-up blockers are already turned off 

 

Adjusting Internet Explorer Page and Print Settings 

 

 

 

To adjust the page and print settings, click on the File menu and then 

select the Page setup option. 
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Set all margins to 0.25 inches (in).  To do that, enter 0.25 in the Left, Right, Top and Bottom fields. Next 

set all the Headers and Footers fields to “Empty”. 

Once you have completed the setup, click on the  button to save. 

 

Setting Compatibility View Options 

 

In order to access Nightingale using Internet Explorer 11, you will need to add the Nightingale sites to 

the Compatibility list. 



Last Updated October 2016   

Nightingale – Getting Started Guide – Windows 10      Page 14 of 19 

 

 

To configure the compatibility view 

settings, click on the Tools menu and 

then select Compatibility View settings. 

 

 

 

 

 

 

 

 

 

 

 

 

Next, you will need to add the Nightingale site(s) you 

use to the Compatibility View list. See the list of 

Nightingale web sites in the table below. To add a 

website name, enter the website address in the Add 

this website field and then click on the  

button. 

Remove the check marks from the checkboxes for 

Use Microsoft compatibility lists and Display 

intranet sites in Compatibility View.  Click Close 

to save your changes. 

Once you have completed the setups, click on the 

 button to save. 
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Add the necessary sites to the compatibility list. 

https://rsa-on.mynightingale.net  NOD – Ontario East 

https://ont.nightingale.md  NOD – Ontario MD  

https://aohc.nightingalemd.com  NOD – AOHC  

https://nod.nightingalemd.com  NOD – Eastern (Outside of Ontario) 

https://rsa-west.mynightingale.net   NOD – Western Canada 

https://west2.nightingalemd.com NOD – Western 2 

https://training.mynightingale.net  Training Server 

 

Updating Internet Explorer Options 

 

In order for Nightingale On Demand to function properly, you will need to adjust some of the Internet 

Explorer security options.   

 

 

 

To access Internet Security options, click on the 

Tools menu and then Internet Options. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Ensure that the checkbox denoting to ‘Delete browsing history on exit’ is checked. 

  

https://rsa-on.mynightingale.net/
https://ont.nightingale.md/
https://aohc.nightingalemd.com/
https://nod.nightingalemd.com/
https://rsa-west.mynightingale.net/
https://training.mynightingale.net/
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Next click on the Security tab, followed by the Trusted Sites icon.   

 

 

 

Once they have been selected, click on the  button. 
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To add a site to your Trusted Sites, enter the Nightingale website address in the “Add this website to the 

zone” field and then click on the  button. 

 

Add the necessary sites which apply to you and uncheck the “Require server verification” checkbox. 

 

 

Once the necessary Nightingale sites have been added, click on the  button, then click OK to 

save settings.  

On the Security tab with the Trusted Sites icon selected, click the Custom level button. In the Reset 

custom settings area, select Medium and click the Reset… button.  

Change the values of the security options to match those listed below. The name of each section has 

been added to make it easier for you to find each option. Settings that are different from the default 

Medium level are highlighted.  

  

https://rsa-on.mynightingale.net  NOD - Ontario East 

https://ont.nightingale.md  NOD - Ontario MD 

https://aohc.nightingalemd.com  NOD – AOHC 

https://nod.nightingalemd.com  NOD - Eastern (Outside of Ontario) 

https://rsa-west.mynightingale.net   NOD - Western 

https://west2.nightingalemd.com NOD - Western 2 

https://training.mynightingale.net  Training Server 

https://rsa-on.mynightingale.net/
https://ont.nightingale.md/
https://aohc.nightingalemd.com/
https://nod.nightingalemd.com/
https://rsa-west.mynightingale.net/
https://training.mynightingale.net/
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ActiveX controls and plug-ins 

Setting NOD Default 

Allow ActiveX Filtering Enable Enable 

Allow previously unused ActiveX controls to run without prompt Enable Enable 

Allow Scriptlets Disable Disable 

Automatic prompting for ActiveX controls Disable Disable 

Binary and script behaviours Enable Enable 

Download signed ActiveX controls Enable Prompt 

Download unsigned ActiveX controls Prompt Disable 

Initialize and script ActiveX controls not marked as safe for scripting Disable Disable 

Only allow approved domains to use ActiveX without prompt Disable Disable 

Run ActiveX controls and plug-ins Enable Enable 

Script ActiveX controls marked safe for scripting * Enable Enable 

 

Downloads 

Setting NOD Default 

File download Enable Enable 

 

Miscellaneous 

Setting NOD Default 

Allow script-initiated windows without size or position constraints Enable Disable 

Allow websites to open windows without address or status bars Enable Enable 

Display mixed content Enable Enable 

Launching applications and unsafe files Prompt Prompt 

Launching programs and files in an IFrame Enable Prompt 

Use Pop-up blocker Disable Enable 
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Scripting 

Setting NOD Default 

Active scripting Enable Enable 

Scripting of Java applets Enable Enable 

 

Click OK. Then select the Advanced tab and click the “Restore advanced settings” button. 

Change the values of the security options to match those listed below. The name of each section has 

been added to make it easier for you to find each option.   

Browsing 

☒ Disable script debugging (Internet Explorer) 

☒ Disable script debugging (Other) 

 

Security 

☒ Allow active content to run in files on My Computer * 

☐ Check for publisher’s certificate revocation 

☐ Check for server certificate revocation * 

☐ Check for signatures on downloaded programs 

☒ Enable native XMLHTTP support 

☐ Use SSL 2.0 

☐ Use SSL 3.0 

☒ Use TLS 1.0 

☒ Use TLS 1.1 

☒ Use TLS 1.2 

  

 

Click OK. Settings marked with an asterisk require a restart to take effect. Restart your PC.  


